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TLV320AIC1103/1110EVM-K

This user's guide describes the characteristics, operation, and use of evaluation modules
TLV320AIC1103/1110EVM-K. A complete circuit description, schematic diagram and bill of materials are
also included.

Throughout this document, TLV320AIC11xxEVM refers to TLV320AIC1103/1110EVM-K.

Related documents are available through the Texas Instruments web site at www.ti.com.
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1 EVM Overview

1.1 Features
• Full-featured evaluation board for the TLV320AIC11xx audio codec
• TLV320AIC11xxEVM-K features USB connectivity for quick and easy setup.
• Intuitive evaluation software
• Easy interfacing to multiple analog sources
• Analog output signals from the TLV320AIC11xx are available on top and bottom connectors.
• External microphone jack and electric microphone are included
• Digital control signals can be applied directly to top and bottom connectors.

1.2 Introduction

The TLV320AIC11xxEVM-K is a complete evaluation/demonstration kit, which includes a USB-based
motherboard called the USB-MODEVM Interface board and evaluation software for use with a personal
computer running Microsoft Windows® XP operating systems only. Provisions are made for connecting all
audio inputs and outputs either from the modular connectors or with on-board terminals and external
microphone jack. An on-board electret microphone is also provided.

2 Analog Interface

For maximum flexibility, the TLV320AIC11xxEVM is designed for easy interfacing to multiple analog
sources. Samtec part numbers SSW-110-22-F-D-VS-K and TSM-110-01-T-DV-P provide a convenient
10-pin dual row header/socket combination. These headers/sockets provide access to the analog input
and output pins of the device. Consult Samtec at www.samtec.com or call 1-800-SAMTEC-9 for a variety
of mating connector options. Table 1 summarizes the analog interface pinout for the TLV320AIC11xxEVM.

Table 1. Analog Interface Pinout

PIN NUMBER SIGNAL DESCRIPTION

1.01 EAR1ON DAC Inverting output

1.02 EAR1OP DAC Noninverting output

1.03 NC Not Connected

1.04 EAR2O DAC Single-Ended Output

1.05 NC Not Connected

1.06 NC Not Connected

1.07 NC Not Connected

1.08 NC Not Connected

1.09 AGND Analog Ground

1.10 NC Not Connected

1.11 AGND Analog Ground

1.12 NC Not Connected

1.13 AGND Analog Ground

1.14 NC Not Connected

1.15 NC Not Connected

1.16 NC Not Connected

1.17 AGND Analog Ground

1.18 NC Not Connected

1.19 AGND Analog Ground

1.20 NC Not Connected

2.01 MIC2N ADC Inverting Input

2.02 MIC2P ADC Noninverting Input

2.03 NC Not Connected
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Table 1. Analog Interface Pinout (continued)

PIN NUMBER SIGNAL DESCRIPTION

2.04 NC Not Connected

2.05 NC Not Connected

2.06 NC Not Connected

2.07 MIC1N ADC Inverting Input

2.08 MIC1P ADC Noninverting Input

2.09 AGND Analog Ground

2.10 NC Not Connected

2.11 AGND Analog Ground

2.12 NC Not Connected

2.13 AGND Analog Ground

2.14 NC Not Connected

2.15 NC Not Connected

2.16 NC Not Connected

2.17 AGND Analog Ground

2.18 NC Not Connected

2.19 AGND Analog Ground

2.20 NC Not Connected

In addition to the analog headers, the analog inputs and outputs may also be accessed through alternate
connectors, either screw terminals or audio jacks. The microphone input is tied to J9. Table 2 summarizes
the screw terminals available on the TLV320AIC11xxEVM.

Table 2. Alternate Analog Connectors

DESIGNATOR PIN 1 PIN 2

J6 EAR1ON EAR1OP

J7 EAR2O AGND

J9 MIC1N MIC1P

J10 MIC2N MIC2P

3 Digital Interface

The TLV320AIC11xxEVM is designed to easily interface with multiple control platforms. Samtec part
numbers SSW-110-22-F-D-VS-K and TSM-110-01-T-DV-P provide a convenient 10-pin dual row
header/socket combination. These headers/sockets provide access to the digital control and serial data
pins of the device. Consult Samtec at www.samtec.com or call 1-800- SAMTEC-9 for a variety of mating
connector options. Table 3 summarizes the digital interface pinout for the TLV320AIC11xxEVM.

Table 3. Digital Interface Pinout

PIN NUMBER SIGNAL DESCRIPTION

J4.1 NC Not Connected

J4.2 NC Not Connected

J4.3 NC Not Connected

J4.4 DGND Digital Ground

J4.5 NC Not Connected

J4.6 NC Not Connected

J4.7 NC Not Connected

J4.8 RESET Reset signal input

J4.9 NC Not Connected

J4.10 DGND Digital Ground
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Table 3. Digital Interface Pinout (continued)

PIN NUMBER SIGNAL DESCRIPTION

J4.11 NC Not Connected

J4.12 NC Not Connected

J4.13 NC Not Connected

J4.14 RESET Reset signal input

J4.15 NC Not Connected

J4.16 NC Not Connected

J4.17 NC Not Connected

J4.18 DGND Digital Ground

J4.19 NC Not Connected

J4.20 NC Not Connected

J5.1 NC Not Connected

J5.2 NC Not Connected

J5.3 SCLK Audio Serial Data Shift Clock (Input/Output)

J5.4 DGND Digital Ground

J5.5 NC Not Connected

J5.6 NC Not Connected

J5.7 FS_1 Audio Serial Data Bus Frame Sync (Input/Output)

J5.8 NC Not Connected

J5.9 NC Not Connected

J5.10 DGND Digital Ground

J5.11 DIN Audio Serial Data Bus Data Input (Input)

J5.12 NC Not Connected

J5.13 DOUT Audio Serial Data Bus Data Output (Output)

J5.14 NC Not Connected

J5.15 NC Not Connected

J5.16 SCL I2C Serial Clock

J5.17 MCLK Master Clock Input

J5.18 DGND Digital Ground

J5.19 NC Not Connected

J5.20 SDA I2C Serial Data Input/Output

Note that J5 comprises the signals needed for a SMARTDM™ serial digital audio interface and I2C™
signals. The reset and power down (RESET and PWRDN) signals are routed to J4. I2C™ is actually
routed from the USB-MODEVM to both connectors; however, the codec and EEPROM are only connected
to J5.
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4 Power Supplies

J3 provides connection to the common power bus for the TLV320AIC11xxEVM. Power is supplied on the
pins listed in Table 4.

Table 4. Power Supply Pinout

SIGNAL PIN NUMBER SIGNAL

NC J3.1 J3.2 NC

+5VA J3.3 J3.4 NC

DGND J3.5 J3.6 AGND

NC J3.7 J3.8 NC

IOVDD (3.3V) J3.9 J3.10 NC

The TLV320AIC11xxEVM-K motherboard (the USB-MODEVM Interface board) supplies power to J3 of the
TLV320AIC11xxEVM. Power for the motherboard is supplied either through its USB connection or via
terminal blocks on that board.

4.1 Stand-Alone Operation

When used as a stand-alone EVM, power can be applied to J3 directly. The user must be sure to
reference the supplies to the appropriate grounds on that connector.

CAUTION

Verify that all power supplies are within the safe operating limits shown on the
product datasheet before applying power to the EVM.

4.2 USB-MODEVM Interface Power

The USB-MODEVM Interface board can be powered from several different sources:
• USB
• 6VDC–10VDC AC/DC external wall supply (not included)
• Lab power supply

When powered from the USB connection, JMP6 should have a shunt from pins 1–2 (this is the default
factory configuration). When powered from 6V-10VDC, either through the J8 terminal block or the J9
barrel jack, JMP6 should have a shunt installed on pins 2-3. If power is applied in any of these ways,
onboard regulators generate the required supply voltages and no further power supplies are necessary.

If lab supplies are used to provide the individual voltages required by the USB-MODEVM Interface, JMP6
should have no shunt installed. Voltages are then applied to J2 (+5VA), J3 (+5VD), J4 (+1.8VD), and J5
(+3.3VD). The +1.8VD and +3.3VD can also be generated on the board by the onboard regulators from
the +5VD supply; to enable this configuration, the switches on SW1 need to be set to enable the
regulators by placing them in the ON position (lower position, looking at the board with text reading
right-side up). If +1.8VD and +3.3VD are supplied externally, disable the onboard regulators by placing
SW1 switches in the OFF position.

Each power supply voltage has an LED (D1-D7) that lights when the power supplies are active.

5 EVM Operation

This section provides information on the analog input and output, digital control, and general operating
conditions for the TLV320AIC11xxEVM.

5.1 Analog Input

The analog input sources can be applied directly to J2 (top or bottom side). The analog inputs may also
be accessed through J8 and screw terminals J9 and J10.
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5.2 Analog Output

The analog outputs from the TLV320AIC11xx are available on J1 (top or bottom). They also may be
accessed through J6 or J7.

5.3 Digital Control

The digital control signals can be applied directly to J4 and J5 (top or bottom side). The modular
TLV320AIC11xxEVM can also be connected directly to the USB-MODEVM Interface board included as
part of the TLV320AIC11xxEVM-K.

5.4 Default Jumper Locations

Table 5 lists the jumpers found on the EVM and their respective factory default conditions.

Table 5. List of Jumpers

DEFAULT
JUMPER POSITION JUMPER DESCRIPTION

W1 Not Installed Coupling for EAR1. Either directly or via capacitor

W2 Not Installed Coupling for EAR2. Either directly or via capacitor

W3 Installed Provides a means of measuring AVDD and EARVDD current

W4 Installed Connects MIC1N to MBIAS through a resistor

W5 Installed Connects MIC2N to MBIAS through a resistor

W6 Installed Connects on-board microphone to circuit

W7 Installed Connects J9 to circuit

W8 Installed Connects external mic source to ground through a resistor

W9 Installed Selects on-board EEPROM as firmware source (required)

W10 Installed Provides a means of measuring DVDD current

W11 Installed Provides a means of measuring PLLVDD current

W12 1-2 Sets PWRUPSEL mode

W13 Installed When installed, allows the USB-MODEVM to hardware reset the device under user control

6 Kit Operation

This section provides information on using the TLV320AIC11xxEVM-K, including set up, program
installation, and program usage.

6.1 TLV320AIC11xxEVM-K Block Diagram

A block diagram of the TLV320AIC11xxEVM-K is shown in Figure 1. The evaluation kit consists of two
circuit boards connected together. The motherboard is designated as the USB-MODEVM Interface board,
while the daughtercard is the TLV320AIC11xxEVM described previously in this manual.
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Figure 1. TLV320AIC11xxEVM-K Block Diagram

The USB-MODEVM Interface board is intended to be used in USB mode, where control of the installed
EVM is accomplished using the onboard USB controller device. Provision is made, however, for driving all
the data buses (I2C, PCM/ SMARTDM™) externally. The source of these signals is controlled by SW2 on
the USB-MODEVM. Refer to Table 6 for details on the switch settings.

Additionally, SW3 on the USB-MODEVM (IOVDD SELECT) must be set up to 3.3V (SW3 position 1 on,
SW3 positions 2-8 off).
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Table 6. USB-MODEVM SW2 Settings

SW-2 SWITCH
NUMBER LABEL SWITCH DESCRIPTION

USB-MODEVM EEPROM I2C Address A0
1 A0 ON: A0 = 0

OFF: A0 = 1

USB-MODEVM EEPROM I2C Address A1
2 A1 ON: A1 = 0

OFF: A1 = 1

USB-MODEVM EEPROM I2C Address A2
3 A2 ON: A2 = 0

OFF: A2 = 1

Digital Audio Bus Source Selection
4 USB I2S ON: Digital Audio Bus connects to TAS1020

OFF: Digital Audio Bus connects to USB-MODEVM J14

Digital Audio Bus MCLK Source Selection
5 USB MCK ON: MCLK connects to TAS1020

OFF: MCLK connects to USB-MODEVM J14

SPI Bus Source Selection
6 USB SPI ON: SPI Bus connects to TAS1020

OFF: SPI Bus connects to USB-MODEVM J15

RST Source Selection
7 USB RST ON: EVM Reset Signal comes from TAS1020

OFF: EVM Reset Signal comes from USB-MODEVM J15

External MCLK Selection
8 EXT MCK ON: MCLK Signal is provided from USB-MODEVM J10

OFF: MCLK Signal comes from either selection of SW2-5

For use with the TLV320AIC11xxEVM, SW-2 positions 1, 3, 4, 5 and 6 should be set to ON, while SW-2
positions 2, 7 and 8 should be set to OFF.

6.2 Installation

Ensure that the TLV320AIC11xxEVM is installed on the USB-MODEVM Interface board, aligning J1, J2,
J3, J4, J5 with the corresponding connectors on the USB-MODEVM.

Go to www.ti.com and type AIC11xx (where xx corresponds to the device under evaluation) on the
"Search by Part Number" field. Locate the "EVM-K" product folder and download the software. Once
downloaded, unzip and locate the Setup program, and start it. The Setup program will install the
TLV320AIC11xx Evaluation Tool software on your PC.

The NI-VISA Runtime installer is embedded to the TLV320AIC11xx Evaluation Tool installer. This software
allows the program to communicate with the USB-MODEVM.

When the installation completes, click Finish on the TLV320AIC11xx Evaluation Tool installer window. You
may be prompted to restart your computer.

When installation is complete, attach a USB cable from your PC to the USB-MODEVM Interface board. As
configured at the factory, the board will be powered from the USB interface, so the power indicator LEDs
and the 'USB ACTIVE' LED on the USB-MODEVM should light.

The Found New Hardware Wizard will show up on the screen. Select the 'No, not this time' radio button
and click 'Next >'. Select 'Install the software automatically (Recommended)' and click 'Next >'. If the
driver installs correctly the message: 'The wizard has finished installing the software for:
USB-MODEVM' should appear. Click 'Finish'. The USB-MODEVM driver should now be installed. The
device should now appear on the Device Manager as 'NI-VISA USB Devices>USB-MODEVM' and as
'Sound, video and game controllers>USB Audio Device'.

Once the device drivers are installed launch the TLV320AIC11xx Evaluation Tool software on your PC,
located on the computer's desktop or in 'Start>Programs>Texas Instruments'.

The software should automatically find the TLV320AIC11xx, and a screen similar to the one in Figure 2
should appear. Select the appropriate device in this screen.
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Figure 2. Device Selection Window

6.3 USB-MODEVM Interface Board

The simple diagram shown in Figure 1 shows only the basic features of the USB-MODEVM Interface
board. The board is built around a TAS1020B streaming audio USB controller with an 8051-based core.
The board features two positions for modular EVMs, or one double-wide serial modular EVM may be
installed.

Since the TLV320AIC11xxEVM is a double-wide modular EVM, it is installed with connections to both
EVM positions, which connects the TLV320AIC11xx digital control interface to the I2C port realized using
the TAS1020B, as well as the TAS1020B digital audio interface.

In the factory configuration, the board is ready to use with the TLV320AIC11xxEVM. To view all the
functions and configuration options available on the USB-MODEVM board, see the USB-MODEVM
Interface Board schematic in Appendix B.

6.4 Program Description

After the TLV320AIC11xxEVM software installation (described in Section 6.2) is complete, evaluation and
development with the TLV320AIC11xx can begin.
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6.5 Indicators and Main Screen Controls

Figure 3. Default Software Screen

Figure 3 illustrates the indicators and the main screen controls near the top of the software screen display,
and a large tabbed interface below. This section discusses the controls above this tabbed section.

At the top left of the screen is an Interface indicator. The TLV320AIC11xx has an I2C interface. The
indicator is lit after the program begins. Below the Interface indicator is the Device Connected indicator.
The TLV320AIC11xx Evaluation Tool detects whether or not the TLV320AIC11xxEVM-K is present. If the
device is unplugged from the USB port or if the device driver is not installed properly, the Device
Connected indicator will turn red. Otherwise, it will turn green.

To the right of the Interface indicator is a group box called Firmware. This box indicates the product
identification of the USB device, so USB-MODEVM should be displayed in the box labeled Located On:.
The version of the firmware appears in the Version box below this.

Indicators on this panel, update only when writing or reading registers, or by pushing the Refresh button.
The Indicator Updates and Control Updates buttons enable/disable updates of indicators and controls,
respectively.

6.6 Information Tab

The information tab (Figure 4) shows information for two TLV320AIC11xxEVM-K hardware configurations.
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The USB-MODEVM Audio Interface Configuration allows audio data and I2C communication between
the host computer and the TLV320AIC11xx. SW2 on the USB-MODEVM must be configured as shown in
the left section of Figure 4.

Figure 4. Information Tab

Additionally, the operating system's audio device must be configured as USB-MODEVM (see Figure 5).

The External Audio Interface Configuration only allows I2C communication between the host computer
and the TLV320AIC11xx. In this configuration, the TLV320AIC11xx can transmit and receive audio data
to/from an external PCM device or DSP. SW2 on the USB-MODEVM must be configured as shown in the
right section of Figure 4.
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Figure 5. Sounds and Audio Devices Properties

6.7 Preset Configurations Tab

The Preset Configurations tab (Figure 6) provides several presets for both the USB-MODEVM Audio
Interface Configuration. Also, there is a TLV320AIC11xx Defaults preset which programs the codec's
default register settings. When a radio button is selected, a detailed description of the preset will appear
on the Preset Configuration Description box. To load a preset to the codec, select the desired preset by
selecting the corresponding radio button and pushing the Load button. At the same time, this will show the
preset's executed commands on the Command Buffer of the Command Line Interface tab (see
Figure 8).
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Figure 6. Preset Configurations

6.8 Device Controls Tab

The Device Controls Tab (Figure 7) contains seven enumerated Control Registers sub tabs with
controls for all registers of the TLV320AIC11xx, a register table at the bottom of the tab, several controls
and an indicator at the right of the tab. The 8-bit I2C Address indicator shows the current I2C address.
The Program Device button, when pushed, programs the register corresponding only to the selected
Control Registers sub tab. The register table holds the current register values in hexadecimal and binary
format. The Register Dump to File button dumps the current register values to a spreadsheet. Please
refer to the respective datasheet for further details on control register content.
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Figure 7. Device Controls Tab

6.9 Command Line Interface Tab

A simple scripting language controls the TAS1020 on the USB-MODEVM from the LabView™-based PC
software. The main program controls, described previously, do nothing more than write a script which is
then handed off to an interpreter that sends the appropriate data to the correct USB endpoint. Because
this system is script-based, provision is made in this tab for the user to view the scripting commands that
are created as the controls are manipulated, as well as load and execute other scripts that have been
written and saved (see Figure 8). This design allows the software to be used as a quick test tool or to help
provide troubleshooting information in the rare event that the user encounters a problem with this EVM.
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Figure 8. Command Line Interface Tab

A script is loaded into the command buffer, either by operating the controls on the other tabs or by loading
a script file or preset.

When executed, either by loading commands from other tabs, loading a preset or pushing the Execute
Command Buffer button, an array containing executed commands will be displayed on the Command
History tab. Additionally, the return packet of data which results from the last command executed will be
displayed in the USB-MODEVM Data Packet tab. The logging function, described below, can be used to
see the results after every executed command.

The File menu (Figure 9) provides some options for working with scripts. The first option, Open Command
File..., loads a command file script into the command buffer. This script can then be executed by pressing
the Execute Command Buffer button.

The second option, Save Command File..., saves the contents of the command buffer into a file.

The third option is Log Script and Results..., which opens a file save dialog box. The user can choose a
location for a log file to be written using the file save dialog. When the Execute Command Buffer button is
pressed, the script will run and the script, along with resulting data read back during the script, will be
saved to the file specified. The log file is a standard text file which can be opened with any text editor, and
looks much like the source script file, but with the additional information of the result of each script
command executed.

The third menu item is a submenu of Recently Opened Files. This list is simply a list of script files that
have previously been opened, allowing fast access to commonly-used script files. The final menu item is
Exit, which terminates the TLV320AIC11xx Evaluation Tool software.
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Figure 9. File Menu

The Options menu provides two settings suitable for command line interface users and for
troubleshooting. These settings allows the user to evaluate the device in its most basic form.

Under the Help menu is an About... menu item (Figure 10) which displays information about the
TLV320AIC11xxEVM software.

Figure 10. Help

The actual USB protocol used as well as instructions on writing scripts are detailed in the following
subsections. While it is not necessary to understand or use either the protocol or the scripts directly,
understanding them may be helpful to some users.

6.9.1 USB-MODEVM Protocol

The USB-MODEVM is defined to be a Vendor-Specific class, and is identified on the PC system as an
NI-VISA device. Because the TAS1020 has several routines in its ROM which are designed for use with
HID-class devices, HID-like structures are used, even though the USB-MODEVM is not an HID-class
device. Data passes from the PC to the TAS1020 using the control endpoint.

Data is sent in an HIDSETREPORT (see Table 7):

Table 7. USB Control Endpoint HIDSETREPORT Request

PART VALUE DESCRIPTION

bmRequestType 0x21 00100001

bRequest 0x09 SET_REPORT
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Table 7. USB Control Endpoint HIDSETREPORT Request (continued)

PART VALUE DESCRIPTION

wValue 0x00 don't care

wIndex 0x03 HID interface is index 3

wLength calculated by host

Data Data packet as described below
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The data packet consists of the following bytes, shown in Table 8:

Table 8. Data Packet Configuration

BYTE NUMBER TYPE DESCRIPTION

Specifies serial interface and operation. The two values are logically OR'd.
Operation:

READ 0x00
WRITE 0x10

Interface
0 Interface :

GPIO 0x08
SPI_16 0x04
I2C_FAST 0x02
I2C_STD 0x01
SPI_8 0x00

1 I2C Slave Address Slave address of I2C device or MSB of 16-bit reg addr for SPI

2 Length Length of data to write/read (number of bytes)

3 Register address Address of register for I2C or 8-bit SPI; LSB of 16-bit address for SPI

Up to 60 data bytes could be written at a time. EP0 maximum length is 64. The return4..64 Data packet is limited to 42 bytes, so advise only sending 32 bytes at any one time.

Example usage:
Write two bytes (45, A0) to device starting at register 1 of an I2C device with address 80:

[0] 0x11
[1] 0x80
[2] 0x02
[3] 0x01
[4] 0x45
[5] 0xA0

Do the same with a fast mode I2C device:

[0] 0x12
[1] 0x80
[2] 0x02
[3] 0x01
[4] 0x45
[5] 0xA0

In each case, the TAS1020 will return, in an HID interrupt packet, the following:

[0] interface byte | status
status:

REQ_ERROR 0x80

INTF_ERROR 0x40

REQ_DONE 0x20

[1] for I2C interfaces, the I2C address as sent
for SPI interfaces, the read back data from SPI line for transmission of the corresponding byte

[2] length as sent
[3] for I2C interfaces, the reg address as sent

for SPI interfaces, the read back data from SPI line for transmission of the corresponding byte
[4..60] echo of data packet sent
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If the command is sent with no problem, the returning byte [0] should be the same as the sent one
logically or'd with 0x20 - in the second example above (fast mode), the returning packet should be:

[0] 0x32
[1] 0x80
[2] 0x02
[3] 0x01
[4] 0x45
[5] 0xA0

If for some reason the interface fails (for example, the I2C device does not acknowledge), it would come
back as:

[0] 0x52 --> interface | INTF_ERROR
[1] 0x80
[2] 0x02
[3] 0x01
[4] 0x45
[5] 0xA0

If the request is malformed, that is, the interface byte (byte [0]) takes on a value which is not described
above, the return packet would be:

[0] 0x93 --> 0x13 was sent, which is not valid, so 0x93 is returned
[1] 0x80
[2] 0x02
[3] 0x01
[4] 0x45
[5] 0xA0

Examples above used writes. Reading is similar:
Read two bytes from device starting at register 1 of an I2C device with address A0:

[0] 0x01
[1] 0x80
[2] 0x02
[3] 0x01

The return packet should be

[0] 0x21
[1] 0x80
[2] 0x02
[3] 0x01
[4] 0x45
[5] 0xA0

assuming that the values we wrote above starting at Register 5 were actually written to the device.
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6.9.1.1 GPIO Capability

The USB-MODEVM has seven GPIO lines. The user can access them by specifying the interface to be
0x08, and then using the standard format for packets—but addresses are unnecessary. The GPIO lines
are mapped into one byte (see Table 9):

Table 9. GPIO Pin Assignments

7 6 5 4 3 2 1 0

x P3.5 P3.4 P3.3 P1.3 P1.2 P1.1 P1.0

Example: write P3.5 to a 0, all others to 1:

[0] 0x18 --> write, GPIO
[1] 0x00 --> this value is ignored
[2] 0x01 --> length - ALWAYS a 1
[3] 0x00 --> this value is ignored
[4] 0x3F --> 00111111

The user may also read back from the GPIO to see the state of the pins. Suppose the port pins were
written as in the previous example.

Example: read the GPIO

[0] 0x08 --> read, GPIO
[1] 0x00 --> this value is ignored
[2] 0x01 --> length - ALWAYS a 1
[3] 0x00 --> this value is ignored

The return packet should be:

[0] 0x28
[1] 0x00
[2] 0x01
[3] 0x00
[4] 0x3F
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6.9.2 Writing Scripts

A script is simply a text file that contains data to send to the serial control buses. The scripting language is
quite simple, as is the parser for the language. Therefore, the program is not very forgiving about mistakes
made in the source script file, but the formatting of the file is simple. Consequently, mistakes should be
rare.

Each line in a script file is one command. There is no provision for extending lines beyond one line. A line
is terminated by a carriage return.

The first character of a line is the command. Commands are:

I = = = = = = = Set interface bus to use
r = = = = = = = Read from the serial control bus
w = = = = = = = Write to the serial control bus
# = = = = = = = Comment
b = = = = = = = Break
d = = = = = = = Delay

The first command, I, sets the interface to use for the commands to follow. This command must be
followed by one of the following parameters:

i2cstd Standard mode I2C Bus
i2cfast Fast mode I2C bus
spi8 SPI bus with 8-bit register addressing
spi16 SPI bus with 16-bit register addressing
gpio Use the USB-MODEVM GPIO capability

For example, if a fast mode I2C bus is to be used, the script would begin with:

I i2cfast

No data follows the break command. Anything following a comment command is ignored by the parser,
provided that it is on the same line. The delay command allows the user to specify a time, in milliseconds,
that the script will pause before proceeding.

NOTE: UNLIKE ALL OTHER NUMBERS USED IN THE SCRIPT COMMANDS, THE DELAY TIME
IS ENTERED IN A DECIMAL FORMAT. Also, note that because of latency in the USB bus
as well as the time it takes the processor on the USB-MODEVM to handle requests, the
delay time may not be precise.

A series of byte values follows either a read or write command. Each byte value is expressed in
hexadecimal, and each byte must be separated by a space. Commands are interpreted and sent to the
TAS1020 by the program using the protocol described in Section 6.9.1.

The first byte following a read or write command is the I2C slave address of the device (if I2C is used) or
the first data byte to write (if SPI is used—note that SPI interfaces are not standardized on protocols, so
the meaning of this byte will vary with the device being addressed on the SPI bus). The second byte is the
starting register address that data will be written to (again, with I2C; SPI varies—see Section 6.9.1 for
additional information about what variations may be necessary for a particular SPI mode). Following these
two bytes are data, if writing; if reading, the third byte value is the number of bytes to read, (expressed in
hexadecimal).
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For example, to write the values 0x45 0xA0 to an I2C device with a slave address of 0x80, starting at a
register address of 0x01, one would write:

#example script
I i2cfast
w 80 01 45 A0
r 80 01 02

This script begins with a comment, specifies that a fast I2C bus will be used, then writes 0x45 0xA0 to the
I2C slave device at address 0x80, writing the values into registers 0x01 and 0x02. The script then reads
back two bytes from the same device starting at register address 0x01. Note that the slave device value
does not change. It is not necessary to set the R/W bit for I2C devices in the script; the read or write
commands will do that for the user.

Any text editor may be used to write these scripts; Jedit is an editor that is highly recommended for
general usage. For more information, go to: http://www.jedit.org.

Once the script is written, it can be used in the command window by running the program, and then
selecting Open Command File... from the File menu. Locate the script and open it. The script will then be
displayed in the command buffer. The user may also edit the script once it is in the buffer and save it as
specified in Section 6.9.

Once the script is in the command buffer, it may be executed by pressing the Execute Command Buffer
button. If the user has placed breakpoints in the script, it will execute to that point, and a dialog box will
show up with a continue button to continue executing the script.

Please refer to sections 3.1 (Power Down and Reset) and section 3.2 (AIC12 Control Register
Programming Procedures) on the TLV320AIC12/13/14/15 Codec Operating In Stand-Alone Slave Mode
application note for important details on programming the codec.

Special care must be taken when writing subregisters (4A-4B and 5A-5D).

Example: w 80 01 45 A0 01 20 B8 00

The previous command writes registers 1, 2, 3, 4A, 5C and 6. It will not increment from 3 to 4A and
then to 4B. The subregister to be written will depend on the data.
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7 EVM Bill of Materials

Table 10 and Table 11 contain a complete bill of materials for the modular TLV320AIC11xxEVM and the
USB-MODEVM Interface Board.

Table 10. TLV320AIC11xxEVM Bill of Materials

REFERENCE DESIGNATOR DESCRIPTION MANUFACTURER MFG PART NUMBER

R9 RES ZERO OHM 1/10W 5% Panasonic ERJ-3GEY0R00V
0603 SMD

R5, R6, R7, R10 RES 10K OHM 1/10W 5% 0603 Panasonic ERJ-3GEYJ103V
SMD

R8 RES 47K OHM 1/10W 5% 0603 Panasonic ERJ-6GEYJ473V
SMD

R2 RES 100K OHM 1/10W 5% 0603 Panasonic ERJ-3GEYJ104V
SMD

R1, R3, R4 RES 2K OHM 1/10W 5% 0603 Panasonic ERJ-3GEYJ202V
SMD

C4, C9, C11 CAP CER .10µF 6.3V X5R 10% TDK Corporation C1005X5R0J104K
0402

C1, C2, C13, C14, C15, C17 CAP CER .1µF 25V X7R 0603 TDK Corporation C1608X7R1E104K

C3, C10, C12 CAP CERAMIC 10µF 6.3V X5R Panasonic ECJ-1VB0J106M
0603

C16, C18 CAP CER 10µF 16V X5R 20% TDK Corporation C3216X5R0J106M
1206

C5, C6, C7, C8 CAP CER 47µF 10V X5R 1210 Murata GRM32ER61A476KE20L

U1 Audio Codec 3.3V Texas Instruments TLV320AIC1110

U2 LDO Voltage Regulator Texas Instruments REG1117-3.3

U3 64K I2C EEPROM MicroChip 24AA64-I/SN

U4 D-Type Flip-Flop Texas Instruments SN74AUP1G74

J6, J7, J8, J10 Screw Terminal Block, 2 Position On Shore Technology ED555/2DS

J9 3.5mm Audio Jack, T-R-S, SMD CUI Inc. / KobiConn SJ1-3515-SMT / 161-3335-E

J1A, J2A, J4A, J5A 20 Pin SMT Plug Samtec TSM-110-01-L-DV-P

J1B, J2B, J4B, J5B 20 pin SMT Socket Samtec SSW-110-22-F-D-VS-K

J3A 10 Pin SMT Plug Samtec TSM-105-01-L-DV-P

J3B 10 pin SMT Socket Samtec SSW-105-22-F-D-VS-K

W1, W2, W4, W5, W6-W9, W13 2 Position Jumper , 0 .1" spacing Samtec TSW-102-07-L-S

W3, W10, W11 Bus Wire (18-22 Gauge)

W12 3 Position Jumper , 0 .1" spacing Samtec TSW-103-07-L-S

MK1 Omnidirectional Microphone Knowles Acoustics / Knowles MD9745APZ-F / MD9745APA-1
Cartridge or alternate Acoustics

SW1 SWITCH LT TOUCH 6X3.5 Panasonic EVQ-PJU04K
240GF SMD

TP1 -TP17 TEST POINT PC MINI .040"D Keystone Electronics 5000
RED

TP18-TP21 TEST POINT PC MINI .040"D Keystone Electronics 5001
BLACK
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Table 11. USB-MODEVM Bill of Materials

Designators Description Manufacturer Mfg. Part Number

R4 10Ω 1/10W 5% chip resistor Panasonic ERJ-3GEYJ100V

R10, R11 27.4Ω 1/16W 1% chip resistor Panasonic ERJ-3EKF27R4V

R20 75Ω 1/4W 1% chip resistor Panasonic ERJ-14NF75R0U

R19 220Ω 1/10W 5% chip resistor Panasonic ERJ-3GEYJ221V

R14, R21, R22 390Ω 1/10W 5% chip resistor Panasonic ERJ-3GEYJ391V

R13 649Ω 1/16W 1% chip resistor Panasonic ERJ-3EKF6490V

R9 1.5kΩ 1/10W 5% Panasonic ERJ-3GEYJ152V
chip resistor

R1, R2, R3, R5, R6, R7, R8 2.7kΩ 1/10W 5% Panasonic ERJ-3GEYJ272V
chip resistor

R12 3.09kΩ 1/16W 1% Panasonic ERJ-3EKF3091V
chip resistor

R15, R16 10kΩ 1/10W 5% Panasonic ERJ-3GEYJ103V
chip resistor

R17, R18 100kΩ 1/10W 5% Panasonic ERJ-3GEYJ104V
chip resistor

RA1 10kΩ 1/8W Octal isolated resistor CTS Corporation 742C163103JTR
array

C18, C19 33pF 50V ceramic TDK C1608C0G1H330J
chip capacitor, ±5%, NPO

C13, C14 47pF 50V ceramic TDK C1608C0G1H470J
chip capacitor, ±5%, NPO

C20 100pF 50V ceramic TDK C1608C0G1H101J
chip capacitor, ±5%, NPO

C21 1000pF 50V ceramic TDK C1608C0G1H102J
chip capacitor, ±5%, NPO

C15 0.1mF 16V ceramic TDK C1608X7R1C104K
chip capacitor, ±10%,X7R

C16, C17 0.33mF 16V ceramic TDK C1608X5R1C334K
chip capacitor, ±20%,Y5V

C9, C10, C11, C12, C22, C23, 1mF 6.3V ceramic TDK C1608X5R0J105K
C24, C25, C26, C27, C28 chip capacitor, ±10%, X5R

C1, C2, C3, C4, C5, C6, C7, C8 10mF 6.3V ceramic TDK C3216X5R0J106K
chip capacitor, ±10%, X5R

D1 50V, 1A, Diode MELF SMD Micro Commercial Components DL4001

D2 Yellow Light Emitting Diode Lumex SML-LX0603YW-TR

D3, D4, D6, D7 Green Light Emitting Diode Lumex SML-LX0603GW-TR

D5 Red Light Emitting Diode Lumex SML-LX0603IW-TR

Q1, Q2 N-Channel MOSFET Zetex ZXMN6A07F

X1 6MHz Crystal SMD Epson MA-505 6.000M-C0

U8 USB streaming controller Texas Instruments TAS1020BPFB

U2 5V LDO regulator Texas Instruments REG1117-5

U9 3.3V/1.8V dual output Texas Instruments TPS767D318PWP
LDO regulator

U3, U4 Quad, 3-state buffers Texas Instruments SN74LVC125APW

U5, U6, U7 Single IC buffer driver with open Texas Instruments SN74LVC1G07DBVR
drain o/p

U10 Single 3-state buffer Texas Instruments SN74LVC1G125DBVR

U1 64K 2-Wire serial EEPROM I2C Microchip 24LC64I/SN

USB-MODEVM PCB Texas Instruments 6463995

TP1, TP2, TP3, TP4, TP5, TP6, Miniature test point terminal Keystone Electronics 5000
TP9, TP10, TP11
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Table 11. USB-MODEVM Bill of Materials (continued)

Designators Description Manufacturer Mfg. Part Number

TP7, TP8 Multipurpose test point Keystone Electronics 5011
terminal

J7 USB type B slave connector Mill-Max 897-30-004-90-000000
thru-hole

J1, J2, J3, J4, J5, J8 2-position terminal block On Shore Technology ED555/2DS

J9 2.5mm power connector CUI Stack PJ-102B

J10 BNC connector, female, AMP/Tyco 414305-1
PC mount

J11A, J12A, J21A, J22A 20-pin SMT plug Samtec TSM-110-01-L-DV-P

J11B, J12B, J21B, J22B 20-pin SMT socket Samtec SSW-110-22-F-D-VS-K

J13A, J23A 10-pin SMT plug Samtec TSM-105-01-L-DV-P

J13B, J23B 10-pin SMT socket Samtec SSW-105-22-F-D-VS-K

J6 4-pin double row header (2x2) Samtec TSW-102-07-L-D
0.1"

J14, J15 12-pin double row header (2x6) Samtec TSW-106-07-L-D
0.1"

JMP1–JMP4 2-position jumper, Samtec TSW-102-07-L-S
0.1" spacing

JMP8–JMP14 2-position jumper, Samtec TSW-102-07-L-S
0.1" spacing

JMP5, JMP6 3-position jumper, Samtec TSW-103-07-L-S
0.1" spacing

JMP7 3-position dual row jumper, Samtec TSW-103-07-L-D
0.1" spacing

SW1 SMT, half-pitch C&K Division, ITT TDA02H0SK1
2-position switch

SW2 SMT, half-pitch C&K Division, ITT TDA08H0SK1
8-position switch

Jumper plug Samtec SNT-100-BK-T
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Appendix A TLV320AIC11xxEVM Schematic

The schematic diagram is provided as a reference.
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Appendix B USB-MODEVM Schematic

The schematic diagram is provided as a reference.
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Evaluation Board/Kit Important Notice

Texas Instruments (TI) provides the enclosed product(s) under the following conditions:

This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION
PURPOSES ONLY and is not considered by TI to be a finished end-product fit for general consumer use. Persons handling the
product(s) must have electronics training and observe good engineering practice standards. As such, the goods being provided are
not intended to be complete in terms of required design-, marketing-, and/or manufacturing-related protective considerations,
including product safety and environmental measures typically found in end products that incorporate such semiconductor
components or circuit boards. This evaluation board/kit does not fall within the scope of the European Union directives regarding
electromagnetic compatibility, restricted substances (RoHS), recycling (WEEE), FCC, CE or UL, and therefore may not meet the
technical requirements of these directives or other related directives.

Should this evaluation board/kit not meet the specifications indicated in the User’s Guide, the board/kit may be returned within 30
days from the date of delivery for a full refund. THE FOREGOING WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY
SELLER TO BUYER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE.

The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user indemnifies TI from all
claims arising from the handling or use of the goods. Due to the open construction of the product, it is the user’s responsibility to
take any and all appropriate precautions with regard to electrostatic discharge.

EXCEPT TO THE EXTENT OF THE INDEMNITY SET FORTH ABOVE, NEITHER PARTY SHALL BE LIABLE TO THE OTHER
FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

TI currently deals with a variety of customers for products, and therefore our arrangement with the user is not exclusive.

TI assumes no liability for applications assistance, customer product design, software performance, or infringement of
patents or services described herein.

Please read the User’s Guide and, specifically, the Warnings and Restrictions notice in the User’s Guide prior to handling the
product. This notice contains important safety information about temperatures and voltages. For additional information on TI’s
environmental and/or safety programs, please contact the TI application engineer or visit www.ti.com/esh.

No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or
combination in which such TI products or services might be or are used.

FCC Warning

This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION
PURPOSES ONLY and is not considered by TI to be a finished end-product fit for general consumer use. It generates, uses, and
can radiate radio frequency energy and has not been tested for compliance with the limits of computing devices pursuant to part 15
of FCC rules, which are designed to provide reasonable protection against radio frequency interference. Operation of this
equipment in other environments may cause interference with radio communications, in which case the user at his own expense
will be required to take whatever measures may be required to correct this interference.

EVM Warnings and Restrictions

It is important to operate this EVM within the input voltage range of 3.3 V to 5 V and the output voltage range of 0 V to 5 V and the
EVM motherboard within the input voltage range of 6 VDC to 10 VDC when using an external AC/DC power supply. Refer to the
USB-MODEVM Interface Power section of this manual when using lab power supplies..

Exceeding the specified input range may cause unexpected operation and/or irreversible damage to the EVM. If there are
questions concerning the input range, please contact a TI field representative prior to connecting the input power.

Applying loads outside of the specified output range may result in unintended operation and/or possible permanent damage to the
EVM. Please consult the EVM User's Guide prior to connecting any load to the EVM output. If there is uncertainty as to the load
specification, please contact a TI field representative.

During normal operation, some circuit components may have case temperatures greater than 30°C. The EVM is designed to
operate properly with certain components above 85°C as long as the input and output ranges are maintained. These components
include but are not limited to linear regulators, switching transistors, pass transistors, and current sense resistors. These types of
devices can be identified using the EVM schematic located in the EVM User's Guide. When placing measurement probes near
these devices during operation, please be aware that these devices may be very warm to the touch.
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI’s standard
warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
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Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
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Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not
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TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
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and any use of TI products in such safety-critical applications, notwithstanding any applications-related information or support that may be
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designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:
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